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Introduction 
NOAA Navigation Response Team 3 (NRT3) is a mobile hydrographic survey team that operates in the 
near‐shore, coastal waters of the northwestern United States.  The team belongs to NOAA’s Navigation 
Services Division (NSD), which provides a focal point for customer requests and associated responses on 
charting issues, short‐term (fast response) hydrographic surveys as well as routine, navigable area 
surveys.  NRT3 is staffed by three Physical Science Technicians. 

Typical stakeholders requesting NRT3 surveys are the U.S. Coast Guard (USCG), local pilot associations, 
the U.S. Army Corps of Engineers (USACE), harbormasters, and NOAA’S National Ocean Service (NOS).  

The Purpose of this report is to give a detailed discussion on NRT3’s equipment, quality control 
methodologies, and corrections to echo soundings. 

A.  Equipment 
 

Vessel 
The primary survey platform for NRT3 is NOAA 
Launch S1212, a 30 foot Commander built by 
SeaArk of Monticello, Arkansas.  NOAA’s Small 
Boat Safety Board categorizes S1212 as a Class II 
Boat, based on the “26 to less than 40 feet length 
overall” vessel classification.   The vessel was 
acquired in January 2001 and modified in August 
of 2004 for the accommodation of two 150 
horsepower Yamaha four‐stroke outboard 
motors.  In October of 2009 the two original 
Yamaha motors were replaced with newer motors 
of the same make and model.  S1212 is eight feet 
wide and displaces 4.8 tons.  S1212 is equipped to acquire vertical beam echosounder (VBES), 
multibeam echosounder (MBES), side scan sonar (SSS) data and shoreline feature data.  S1212 is also 
outfitted with a Kohler generator (model 7.3E), which provides 110 VAC power for survey equipment. 
NOAA Launch S1212 was surveyed by the National Geodetic Survey on June 21, 2006 in Seattle, WA.  
The boat was hauled out of the water, placed on its trailer and leveled with jacks.  The target atop the 
Inertial Motion Sensor (IMU) served as the primary reference point (RP) for the survey.  An XYZ 
coordinate system, each 100 meters from this IMU Reference Point served as the reference frame.   
Horizontal and vertical accuracy for all objects was +/‐ 1 centimeter at the 95% confidence level.  Please 
reference Appendix 1 for complete documentation of this full vessel survey. 

 

SeaArk Commander, S1212 
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Positioning Systems 
A wiring diagram detailing survey equipment configuration may be found in Appendix 2. 

Applanix POS/MV 
NOAA Survey Launch S1212 is equipped with an Applanix 
Model 320, Version 4 POS/MV, interfaced with POS View 
controller software installed on the acquisition computer.  
The POS/MV is a GPS‐aided inertial navigation system 
which provides a blended position solution derived from 
both an Inertial Motion Unit (IMU) and an integrated GPS 
receiver.  With this arrangement, positional accuracy is 
preserved during short GPS outages.  

The IMU contains three solid‐state, linear accelerometers and three, solid state, gyros and provides 
angular accuracy to better than 0.05 degrees.  Antennae for POS/MV systems are mounted on a 
horizontal bar, atop the vessel’s cabin.  The DGPS antenna is mounted atop S1212’s folding aluminum 
mast.  The IMU is mounted below deck, just forward of the vessel’s AC generator.  

A GAMS calibration was performed on March 7, 2011.  The results were as follows:  

  Baseline Vector: X Component=1.903, Y Component=.015, Z Component=.025. 

  Two Antennae Separation: 1.903 

Following an IMU failure and replacement, a second GAMS calibration was conducted on October 25th, 
2011, DN298.  The results, effecting Sheet H12312, were as follows: 

  Basline Vector: X Component = 1.902, Y Component = .015, Z Component .025. 

  Two Antennae Separation= 1.902 

See Appendix 3 for a complete report for 2011’s HSRR GAMS Calibration. 

Applanix “TrueHeave” values were recorded for OPR‐N360‐NRT3‐11 and processed using a delayed 
filtering technique to eliminate artifacts present in real time heave data.  TrueHeave data were applied 
to Simrad bathymetry in CARIS HIPS post processing. 

Trimble GeoXH 
NRT3  uses  a  Trimble  GeoXH  2008  Series  GPS  for  shoreline‐
feature  positioning  and  attribution.    The  GeoXH  uses  the 
Windows Mobile 6 operating system to run TerraSync, a Trimble 
field‐software program used  to  configure  receiver  settings and 

POS/MV and IMU

Trimble GeoXH 
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acquire data.   NRT3  transfers and post‐processes  these data using Trimble Pathfinder Office software 
v4.20, installed on workstations in the office trailer.  
The  GeoXH  provides  reliable  accuracy  to  within  1  to  3  meters  with  real‐time  or  post‐processed 
differential correction.   
To achieve higher accuracy, the GeoXH can employ H‐Star technology, a logging and processing schema 
that provides 10‐ to 30‐cm accuracy.  H‐Star logging requires three or more, dual‐frequency (L1 and L2) 
base stations within 200 km of the receiver or 1 dual frequency base station within 80 km.  However, the 
optional Zephyr antenna must be used to attain accuracies below 30 cm.  NRT3’s GPS settings for OPR‐
N360‐NRT3‐11 conform to the specifications set forth in 2011 Field Procedures Manual, Paragraph 3.5.3.   
 

Trimble GeoXH Settings

Setting Option

Datum  WGS 1984

Altitude Reference  Height Above Ellipsoid

Coordinate System  Latitude/Longitude

Altitude Units  Meters

Distance Units  Meters

Area Units  Square Meters

North Reference  True

Latitude/Longitude Format DD.MM.SS.ss

Angle Units  Degrees

Real‐time setting, choice 1 Integrated SBAS (WAAS)

HDOP  2.5

Elevation Mask  10 Degrees
Table 1 Trimble GPS Settings 

Trimble DSM‐212L 
S1212 is equipped with a Trimble DSM‐212L receiver.  It is an integrated 12‐channel GPS receiver and 
dual channel DGPS beacon receiver.  There 3 modes of operation: Auto Range, Auto Power, and Manual.  
Auto Range mode automatically selects the closest USCG DGPS beacon while Auto Power automatically 
selects the USCG DPS beacon with the strongest signal.  Manual mode does neither; rather it prompts 
the user to input a desired frequency/beacon for use.  The controller software TSIP Talker, version 2.0, 
for DSM‐212L is installed onNRT3’s data acquisition computer. 

NRT3 usually operates DSM‐212L in manual mode, outputting an “RTCM” corrector message to the 
POS/MV.  It is configured to go offline when the age of the GPS correctors exceed 20 seconds.  
Additionally, the DSM‐212L is programmed to reject all satellite vehicles lower than 8 degrees above the 
horizon.  

Sound Speed Measurement Instruments 
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Odom Digibar Pro 
Flat‐faced transducers, such as NRT3’s Kongsberg EM 3002 
SWMB require continuous sound speed measurement at the 
water’s surface.  As such, an Odom Digibar Pro sound speed 
probe measures surface temperature, conductivity and 
pressure to correct for refraction errors at the 
water/transducer interface.  The instrument’s probe is 
mounted on the outside, bottom of the S12121’s transom, 
just forward of the outboard motors.  Its measurements, 
accurate to 0.3 meters per second, are sent to a 
controller/display unit and then relayed to NRT3’s acquisition computer via RS232 cabling.  Digibar Pro 
settings for integration with Hypack and Simrad software are listed in the Table 2.         

COM>Output>Type AML

COM>Output>During Yes

COM>Baud Rate 9600

Setup>Time Interval 1

Setup>Depth 
Interval 

.5

Setup>Units Meters

Setup>Store Cast 
Data 

No

Setup>Depth 
Average 

4

Setup>Velocity 
Average 

1

Simulator Off

          Table 2 Digibar Settings 

 

 

Digibar Pro
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Sea‐Bird SeaCat SBE 19, SeaCat SBE19+ CTD Profiler 
NRT3 collects conductivity, temperature and density (CTD) data using Seabird’s SBE 19+ profiler to 
determine sound speed profiles, which are used to correct multibeam sonar data.  The SBE 19 generates 
a raw hexadecimal file (*.hex) which is used by VELOCWIN, a NOAA in‐house program that converts .hex 
files to files used to correct multibeam data.  (VELOCWIN is discussed Section C.) Please reference 
Appendix 4 for annual manufacturer’s calibration data for all sound speed profilers.   

Depth Measuring Equipment 

Side Scan Sonar (SSS) 
NRT3 operates a Klein 3000 side scan sonar system, 
used for detecting submerged wrecks and obstructions.  
The system operates at 500 kHz and 100 kHz and is able 
to provide side scan data from ranges of 25 to 450 
meters.  Included in the system are:      
       

⋅ Transceiver Processing Unit (TPU) 

⋅ Workstation Display and Control Unit (WDCU) 

⋅ Thirty‐five meters of Kevlar reinforced tow cable  

⋅ SonarPro software and VX Works TPU operating system. 

The  horizontal,  or  along‐track,  beam‐widths  for  the  low  and  high  frequencies  are  0.7°  and  0.21°, 
respectively; the vertical, or across‐track, beam‐width is 40°.  Maximum range scale for the Klein 3000 is 
150 meters at high frequency and 450 meters at low frequency.  During data collection, high‐frequency 
data are recorded while the low‐frequency data are only monitored.  

Multibeam Echosounder (MBES) 
S1212 is equipped with Kongsberg’s EM3002 multibeam echosounder (MBES) installed December, 2009.  
The EM3002 replaced an older EM3000.  No structural modifications of the boat hull were necessary to 
install  the  EM3002,  which  has  the  same  physical  dimensions  and  mounting  configuration  as  the 
EM3000.  The processing unit (PU) was also replaced.  

The EM3002 operates at a nominal frequency of 300 kHz, with a typical range of 1 to 200 meters (in cold 
ocean water) and a range resolution of 1 cm.  It has 254 beams covering a 130° maximum swath width.  
The transmit beam width is 1.5°, and the receive beam width ranges from 1.5° (at nadir) to 3° (60° from 
nadir).   

   MBES, hull‐mounted on S1212 
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The system is pitch‐stabilization capable, but NRT3 generally does not run with pitch‐stabilization 
enabled, to simplify any potential post‐processing requirements.  The cylindrical sonar head is mounted 
to the hull of the vessel at the keel, beneath the inertial measurement unit (IMU). 

Vertical Beam Echo Sounder (VBES) 
An Odom Echotrac CV vertical beam echosounder (VBES) employing a single‐frequency transducer with 
beam width set at eight degrees is used for single beam data collection.  The echosounder, which is 
operated at 200 kHz, records both analog and digital data which may be acquired in feet or meters.  
Soundings are acquired in meters with an assumed speed of sound through water of 1500 m/sec.  
During data collection the echosounder is controlled and the trace is monitored via an Ethernet driver 
connection to the HYPACK Survey program.  The echosounder trace is recorded to .BIN files which are 
logged automatically alongside HYPACK line files during acquisition.  These files are used for reference 
during digital data processing.  HYPACK Max Survey Software is used for vessel navigation and line 
tracking during hydrographic data acquisition.  The HYPACK software log “raw” VBES data and record 
detached positions in the format of “.tgt” files.   

Currently, the Odom vertical beam echosounder control software is out of date and unstable.  In 
addition to installing new controller software, updating the VBES system is not the primary tool for 
acquiring bathymetric data.  NRT3 will need to send the transceiver to Odom for an estimate upgrade 
cost, should NSD deem it worthwhile. 

Lead Line 
For purposes of data integrity, NRT3 has in its possession one (1) 30 meter long lead line.  The lead line 
was fabricated and calibrated in April, 2010. Lead line checks are performed periodically throughout the 
project to verify fathometer accuracy.  The line is graduated in 1 decimeter increments by bands of tape 
along the entire length of the polypropylene line.  Annual calibration each year involves comparing the 
length of the lead line against a survey grade, steel tape in accordance with FPM Section 1.5.3.1.1.  See 
Appendix 7. 

Computers and Software 
A complete tabulation of computers and operating systems is included in the Appendix 5. 

Office and Vessel Workstations 
NRT3 possesses 4 Dell workstations and one Dell laptop.  All computers except the acquisition computer 
are set up in the mobile office.  The acquisition computer is rack mounted inside S1212’s cabin and is 
solely dedicated to vessel navigation and data collection.  The office computers are used for office tasks 
such as data processing, project reporting, computer‐based training, and email correspondence with 
headquarters.  Each office workstation and the laptop run the Windows XP operating system and are 
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networked to three Buffalo Terrastation Pro servers.  Each server has a 1TB storage capacity.  Refer to 
Appendix 5, Hydrographic Systems Inventory for all computer specifications. 

Software 
A complete list of software and versions is included in Appendix 5, Hydrographic Systems Inventory. 

• Hypack 
Simrad MBES data for Southern Puget Sound were collected on S1212 using HYPACK 2009a 
hydrographic survey software.  Data was logged in the ASCII (.hsx) format. 
Due to multiple computer freeze‐ups, NRT3 migrated to HYPACK 2011 on August 25, DN237. 

• Sonar Pro 
Klein Associates’ Sonar Pro 11 software was not used for OPR‐N360‐NRT3‐11. 

• CARIS Hips/Sips 
OPR‐N360‐NRT3‐11 bathymetry was processed with CARIS Hydrographic Information Processing System 

(HIPS) 7.1, Hotfix 3.   

• HSTP Software and MapInfo 
All PCs are also loaded with the latest versions of Pydro and MapInfo(10.0)  – programs used for survey 
planning and preparation, feature and data management, and compilation of the Descriptive Report. 
NOAA’s Pydro software supplied by the Hydrographic Systems and Technology Program (HSTP) was used 
for shoreline feature attribution, for processing and editing detached positions, and for decimating data 
in the creation of preliminary smooth sheet (PSS) files. 
HSTP’s HydroMI Mapbasic program was used  in combination with MapInfo  software  for a number of 
pre‐ and post‐survey applications.  
HSTP’s VelocWin v8.96 program was used to process sound velocity data obtained with Seacat SBE‐19 
and SBE 19 plus CTD’s and an Odom Digibar profiler. 

B.   Data Processing and Quality Control 
 

Project Management 
NRT’s data processing and quality control procedures are described in flow diagrams, Appendix 8. 
 
NRT3’s Project Instructions precipitate from the NSD Headquarters, Silver Spring, MD to NRT3’s Team 
Leader.  They are reviewed by all team members.  Preliminary questions and concerning the project’s 
specified requirements are addressed and resolved via voice conference and/or email correspondence 
prior to survey sheet assignments. 
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Ideally, members manage their own, individual sheet; however, depending upon the project size, this 
plan may not be possible.  Thusly, a survey sheet may become a small, collaborative project, with 
divided responsibilities. 
 
Typically the sheet manager and a teammate will spend a day collecting data.  Upon the close of 
operations, the sheet manager converts and applies (batch processes) correctors/filters in CARIS HIPS 
7.1.  The newly acquired data is added to the BASE surface for quick assessment and for planning the 
next day’s operations.   
 
Additional, directed editing methods are reserved for foul weather days when a surface is more carefully 
analyzed, re‐gridded and added to a survey‐wide BASE surface.  Ultimately, this survey‐wide surface is 
finalized and submitted to the Pacific Hydrographic Branch (PHB), Sand Point, WA. 
 
Quality control reviews occur throughout data acquisition and processing in accordance with all 
applicable guidance (FPM, HSSD) by the Team Leader. Thorough documentation of all sound speed, 
tidal, and systematic artifacts occur during this phase of the project.  The Team Leader accomplishes a 
complete review of the project, once data acquisition has ended.  Recommended changes are passed 
back to the sheet manager before finally being submitted to PHB. 
 
Multibeam Echosounder Data 
NRT3’s data acquisition begins by creating polygons in CARIS Notebook.  First, polygons are drawn to 
shrink the survey sheet into smaller, more manageable pieces, several of which may be completed in 
one boat day.  A chart’s contours and soundings ‐ intrinsic to a polygon’s design ‐ govern their shape 
(longitudinal, parallel to shore) while charted soundings dictate the appropriate coverage resolution per 
the FPM.  This way, coxswains know where to acquire bathymetry and the sheet manager is apprised of 
the appropriate matrix resolution for Hypack’s Hysweep add‐on module.  Next, the polygons are 
exported from CARIS Notebook in the “.000” format and overlaid onto an electronic chart display in 
HYPACK 2011.  Finally, the matrix, a MBES coverage grid depicting the sonar swath, is “painted” inside 
the polygon in real time, as data is acquired aboard S1212.  Matrices are now the sole method through 
which survey coverage is assessed while collecting MBES data on NRT3.  (Prior years relied on planned 
line files.) 
 
NRT3’s main MBES data review and cleaning tool is the Combined Uncertainty Bathymetric Estimator 
(CUBE) ‐ a weighting algorithm executed from the CARIS HIPS program.  During CUBE surface creation, 
soundings are weighted and contribute to surface grid nodes based on uncertainty values and distance 
from the nodes.   
 
As soundings are propagated to a node, a hypothesis representing a probable depth value is developed 
for the node.  A node can contain more than one hypothesis.  Should a sounding value differ significantly 
from its neighbors CUBE creates an alternative hypothesis resulting in a new node and correlating 
surface.  Ultimately, the finalized surface is produced through careful choosing of hypotheses for each 
resolution/depth range (i.e. 1 meter/0 to 20 meters depth, 2 meter/ 18 to 40 meters depth, etc.).   
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An individual sounding’s uncertainty, or Total Propagated Uncertainty (TPU), is derived from the 
assumed uncertainty in the echosounder measurement itself, as well as the contributing correctors from 
sound speed, water levels, position, and attitude.  TPU values for tide and sound velocity must be 
entered for each vessel during TPU computation.  See table 3.  
 

• Tide values measured uncertainty value is the RSS of the error estimates associated 
with each six minute tidal value. 

• Tide values zoning is provided with tide report for each project at the 95% CL.  The 
value must be divided by two before it can be entered into CARIS (which expects a 1 
sigma value). 

• Sound Speed value measured error ranges from 0.5 to 4 m/s, dependent on 
spatial/temporal variability.  Based on the practical experience gained from NOAA SHIP 
RAINIER and NOAA SHIP FAIRWEATHER, a value of .5m seems to be the best value for 
modeling this error. 

• Sound Speed value surface is dependent on the manufacturer specifications of unit 
utilized to measure surface SV values for refraction corrections to flat‐faced transducers.  
For NRT3’s purposes this unit is an Odom Digibar Pro. 

 
  

Vessel  Tide 
values 

Measured 

Tide 
Values 
Zoning 

Sound Speed Values 
Measured 

Sound Speed Values, 
Surface 

Simrad 
3002 

0.01  0.12  0.5  0.3 
 

Table 3 TPU Values 

All other error estimates are read from the Hydrographic Vessel File (HVF) and Device Model File.  The 
HVF contains all offsets and system biases for the survey vessel and its systems, as well as error 
estimates for latency, sensor offset measurements, attitude and navigation measurements, and draft 
measurements.  

The exact behavior of CUBE is determined by the values set in the CUBE parameters file, a .xml file which 
can be selected by the user in CARIS Tools‐>Options‐>Environment tab.  The Hydrographic Surveys 
Division (HSD) has created and provided a customized CUBE surface that is required for each grid 
resolution (CUBParams_NOAA_2011.xml).  During the creation of CUBE surfaces the user is given the 
option to select parameter configurations based upon surface resolutions which have been tuned to 
optimize the performance of the CUBE algorithm (i.e. 0‐20 meters depth  = 1m resolution, 18‐40 meters  
depth = 2m resolution, etc. 

NRT3’s raw multibeam data is processed in CARIS HIPS and SIPS 7.1 in the following sequence: 

1.  Raw “.hsx” files from HYPACK are converted to the HDCS data format. 
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2. Predicted/Preliminary Tides are loaded from the FETCHTIDES utility. 
3. Sound velocity IS NOT loaded, since it was already applied in real‐time in SIS. 
4. Data is “Merged” – CARIS applies position, attitude, vessel offsets and dynamic draft correctors 

to bathymetry to compute the corrected depth and position of each sounding. 
5. Total Propagated Uncertainty is computed for each sounding. 
6. CUBE surfaces are created at appropriate resolutions, as dictated by the following depth ranges 

in Table 4, per FPM 2011. 

7. Finally, swath data is examined in Subset Editor where noise (i.e. fliers, double pings) are 
rejected, tidal and sound speed artifacts assessed and documented, and seafloor depths are 
compared against charted soundings.  Examining data for systematic errors such as tide or 
dynamic draft artifacts is accomplished by exaggerating a surface’s vertical axis by a factor of 3 
or more and comparing overlapping soundings from adjacent survey lines.  

See processing workflow diagram entitled Raw Data to HDCS in Appendix 8. 
 

Resolution squared (meters)  Depth range (meters) 

1m  0‐20 

2m  18‐40 

4m  36‐160 

8m  72‐160 

    Table 4   CUBE Surface Resolutions 

From time to time, a CUBE surface may not accurately capture the shoalest points of irregular features 
such as rock pinnacles or pilings.  In such cases, NRT3 manually “designates” the shoalest sounding and 
documents their findings in the Descriptive Report.  The sounding will be “honored” by the CUBE surface 
upon finalization. 

As a quality control measure, NRT3 acquires crossline data perpendicular to the main scheme lines of 
prior days and compares the results in subset mode.  The total length of these crosslines is 4 % or more 
of the total length of all main scheme lines on a survey sheet in accordance with NOS 2011 Hydrographic 
Specifications and Deliverables (HSSD) paragraph 5.2.4.3. 

Feature Data 
OPR‐N360‐NRT3‐11 shoreline features were received with the project instructions issued from the 
Navigation Response Branch.  Limited shoreline verification was accomplished using the Project 
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Reference File (PRF) and the Assigned Feature File (AFF) provided with the project instructions.  The PRF 
contains the limits of the assigned survey area and the Automated Wreck and Obstruction Information 
System (AWOIS) features and search radii.  The AFF is a subset of the Composite Source File (CSF) which 
includes those features specifically assigned for investigation by this survey. Both the PRF and the AFF 
are S‐57 attributed datasets in .000 file format.   

Limited shoreline verification was conducted near predicted low water in accordance with the 
Specifications and Deliverables and FPM sections 4.4.5. and 4.4.6.  Assigned features seaward of the 
Navigation Area Limit Line (NALL) were addressed as required, S‐57 attributed and recorded in the 
appropriate CARIS Notebook (v3.0, SP1, HF1) .hob files indicated in Table 5 and submitted with this 
survey.   

Shoreline File  Description 

HXXXXX_Original_AFF.hob 

 

Original source data (0_1AFF01.000) as provided for 
project OPR‐N360‐NRT3‐11 and clipped to the limits of 
survey H123XX and converted to .hob format. 

HXXXXX_Field_Verified_AFF.hob 

 

An exact copy of H12311_Original_AFF.hob modified by 
the field unit to best represent shoreline features at 
survey scale.  This includes addition of new features and 
modification of source features.  This file retains all 
features neither verified nor disproved by this survey. 

HXXXXX_Disprovals.hob  Features deleted from H123XX_Field_Verified.hob based 
on survey findings. 

0_4PRF01.000 (example)  Project Reference File with survey limits and AWOIS item 
positions and search radii. 

Table 5 Feature Data 

Additional features including Dangers to Navigation (DTON) and Automated Wreck and Obstruction 
Information System (AWOIS) items were processed using Pydro version 11.10 and included in each 
survey’s feature report, Appendix 2 of the Descriptive Report. 

C.  Corrections to Soundings 

Sound Speed 
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The speed of sound through the water is determined by sound velocity casts conducted in accordance 
with the NOS Hydrographic Surveys Specifications and Deliverables (HSSD). Corrections for speed of 
sound through the water column are computed from data obtained from Seabird’s SBE‐19 Seacat CTD, 
SBE‐19 Plus, and an Odom Digibar Pro sensor. NOAA’s VelocWin, Version 8.96 software is used to 
process casts and generates sound velocity files for CARIS HIPS.  
Although sound velocity correctors are normally applied to sounding data in CARIS HIPS after data is 
acquired, NRT3’s flat‐faced multibeam echosounder dictates a different method.  Velocity casts are 
applied real‐time in Simrad’s SIS acquisition program through use of two sensors.  One sensor (Digibar 
Pro) is transom mounted and continuously sends surface readings to SIS for the purpose of beam 
formation.  The second sensor, the SBE‐19/19 Plus, is used several times a day to capture complete SV 
water column profiles which are applied real‐time in SIS, as soundings are logged.  Operators are 
prompted to take a new cast when surface readings between the two sensors differ by more than 2 
meters a second. See processing workflow diagram entitled RAW SSS Data to HDCS in Appendix 8.   
 
Currently, NRT3 is working with HSTP and other NRTs on a more desirable acquisition configuration and 
processing workflow for sound speed.  Calibration reports for the Odom Digibar, SBE‐19 Seacat and SBE‐
19 Seacat Plus are included in Appendix 4. 

Static Draft 
The Static Draft of S1212’s Multibeam Echosounder  (MBES)  is  the distance  from  the waterline  to  the 
MBES  transducer.   To determine  the  “static draft”  (i.e.,  the height of  the waterline above/below  the 
reference  point),  two  new  reference marks  and  an  easily  repeatable method  were  established.    A 
reference mark was established on  the port and  starboard gunwales,  closely aligned with  the RP, or 
IMU, in the along ship dimension (Figure 2, below). 

The static draft was calculated by subtracting the waterline‐to‐gunwale vertical distance (0.631 m) from 
the RP‐to‐gunwale vertical distance (0.608 m) in Figure 1. 

 
Figure 1   Static Draft Measurement   
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The hydrographer found excellent agreement between the original NGS Survey of the waterline and the 
HSRR verification survey performed  in February, 2011.   A 1 millimeter difference was noted; however 
the original value of .022 meters shall be retained in the Hydrographic Vessel File.  Refer to Appendix 6 
and Figure 1. 

Dynamic Draft 
To determine S1212’s Dynamic Draft, MBES data were collected on DN087 April, 2011 employing the 
FPM’s “Echosounder Method” in Chapter 1.4.2.1.2.  Data were acquired during high, slack tide in calm 
waters of Gig Harbor, Washington.  Depths were 8 to 10 meters in this area and afforded a relatively 
flat, featureless seafloor.  

Upon processing the soundings and plotting their speed vs. depth, it became immediately evident that 
the speed range was inadequate, compared with the previous year.  Historical speed/rpm values ranged 
from 1 to 13 knots but the Gig harbor sounding values ranged from 1 to 7 knots.  Although there was 
close correlation between 2010 and 2011s’ draft difference values within the 1 to 7 knot speed range, 
NRT3 will not be utilizing these values on account of their incompleteness.  NRT3 will continue to use 
2010’s HVF Draft values which provide a more thorough model of speed vs. draft.  See Hydrographic 
Vessel File in Appendix 6 for current draft values. 

Draft (Meters)  Speed (Meters per Second) 
.01  2.41 
.01  2.74 
.02  3.08 
.03  3.49 
.03  3.80 
.04  4.08 
.04  4.20 
.04  4.44 
.02  4.80 
‐.01  5.42 
‐.05  6.39 

Table 6:  Dynamic Draft Values, 2011 Field Season. 

True Heave 
Heave data is calculated using a double integration of acceleration over a period of time.  When 
recording heave in real‐time, the calculation is performed using only past measurements of acceleration.  
An improved estimate of vessel low‐frequency heave can be calculated by performing the integration of 
a time period centered on the time of interest, resulting in “true heave.”   
Employing the POS/MV4 and the POS MV Controller version 4.3.4.0 NRT3 continuously records true 
heave during MBES surveys by selecting “Heave Time 1” in POS View.  NRT3 post‐processes the data in 
CARIS HIPS via the Load True Heave Tool.  
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Tide Corrections 
The vertical datum  for  this project  is Mean Lower‐Low Water  (MLLW).   The operating National Water 
Level Observation Network  (NWLON) stations at Tacoma, WA  (944‐6484) served as datum control  for 
the  survey  area.    No  tertiary  gauges  were  required.  As  per  the  Project  Instructions;  all  data  were 
reduced to MLLW using the final approved water levels (smooth tides) from these stations by applying 
tide  files  9446484.tid  with  time  and  height  correctors  through  the  zone  corrector  file, 
N360NRT32011CORP.zdf. Preliminary zoning was accepted as the final zoning for the H12311.  It will not 
be necessary for the Hydrographic Branch to reapply the final approved water  levels (smooth tides) to 
the survey data during final processing. 
The request for Final Approved Water Levels for H12311 was submitted to CO‐OPS on June 24, 2011 in 
accordance with the Field Procedures Manual (FPM), dated April, 2011. The Final Tide note was received 
on July 7, 2011. 

MBES Patch Test 
Per FPM, paragraph 1.5.5.1.2 a MBES Calibration (Patch Test) should be conducted annually to quantify 
the accuracy, precision, and alignment of the MBES.  Accordingly, NRT3 ran 8 calibration lines on April  
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19, 2011 in Carr Inlet, WA to discover angular and timing biases.  Sounding data was processed with 
CARIS HIPS 7.0 using the software’s “Calibration Mode.”  New angular and timing offsets were entered 
into the hydrographic vessel file (HVF) included Appendix 6.  Value differences from prior years 
exhibited excellent (sub‐degree) conformity.  Five, randomly chosen observations per axes were 
performed independently by each team member.  Results are listed in Table 7. 

A second patch test was performed on October 25, 2011 subsequent to an IMU replacement.  Sounding 
data was processed with CARIS HIPS 7.1 using the calibration mode.  The new values were entered in the 
HVF on DN299.  These values were only applicable to Sheet H12312, Northern Carr Inlet and can be 
found in the HVF, Appendix 6. 

SSS Calibration 
In accordance with FPM Paragraph 1.5.7.1.2 a SSS confidence test was carried out on DN116 using a 75 
meter range scale.  A prominent rock on the Wyckoff Shoal was used as a target (below graphic).  Each 
of 9 passes successfully esonified the rock target however, a systematic horizontal error was evident in 
CARIS  Side  Scan  Editor  during  post‐processing.    The  error  in  both  axes  exceeded  the  10  meter 
confidence radius error budget.  An improper layback value of 7.4 meters and 4 knot currents are likely 
factors which confounded this test. NRT3 will be replacing this SSS system with a newer EdgeTech 4125, 

Table 7: 2011 Patch Test Results 

Figure 2  Patch Test Lines, Wyckoff Shoal, Chart 18448.
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in Fall, 2011 and has not used SSS in the rocky, deep undersea terrain of Puget Sound.  For this reason, 
NRT3 chose to register the system’s deficiency as a Category 2 in the 2011 HSRR Memo.  

 
Figure 3:  SSS Contacts, Wyckoff Shoal, Chart 18448. 
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D.  Approval Sheet 
 

 
As Chief of Party,  I have ensured  that  standard  field  surveying and processing procedures were used 
during  this project  in accordance with  the Hydrographic Manual, Fourth Edition; Hydrographic Survey 
Guidelines; Field Procedures Manual, and the NOS Hydrographic Surveys Specifications and Deliverables 
Manual, as updated for 2011. 

I acknowledge that all of the information contained in this report is complete and accurate to the best of 
my knowledge. 

 

 

 

 

 

 

 

 

Approved and Forwarded: 

 

 

 

_________________________________ 

Dan Jacobs, Team Lead 

Navigation Response Team 3 
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Appendix 1:  NGS Spatial Relationship Survey Report 

 

 

 

 

US DEPARTMENT OF COMMERCE 

NATIONAL OCEANIC & ATMOSPHERIC ADMINISTRATION 

NATIONAL OCEAN SERVICE 

NATIONAL GEODETIC SURVEY 

GEODETIC SERVICES DIVISION 

INSTRUMENTATION & METHODOLOGIES BRANCH 

 

NOAA SURVEY VESSEL S1212 

POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

FIELD REPORT 

 

 

Kendall L. Fancher 

JUNE 21, 2006 
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NOAA SURVEY VESSEL S1212 

POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

 

 

PURPOSE 

 

The primary purpose of the survey was to accurately determine the spatial relationship of various 
sensors, and the components of a POS MV navigation system aboard the NOAA survey vessel  S1212.   

 

PROJECT DETAILS 

 

This survey was conducted in Seattle, WA on the 21st of June, 2006.  The weather was cool and overcast 
in the morning, with warm and partly cloudy conditions in the afternoon.  The vessel was hauled out of 
the water and placed on its trailer to conduct this survey.  The water mark stain around the perimeter of 
the vessel was used to level up the vessel.  Vertical angles were measured at two water marks on the 
stern, and one mark near the bow.  Two trailer jacks located at the rear of the trailer, and the trailer 
tongue jack, were manipulated based upon the vertical angles measured, until they were in coincidence 
with one another.  

 

 

INSTRUMENTATION 

 

The Leica (Wild) TC2002 precision total station was used to make all measurements. 

Technical Data: 
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     Angle Measurement 

      Resolution      0.03 seconds 

      Smallest unit in display  0.1 seconds 

 

    Standard Deviation 

      Horizontal angle    0.5 seconds 

      Vertical angle      0.5 seconds 

      Distance measurement  1mm + 1ppm 

 

Standard “peanut” prisms were used as sighting targets.  Prisms were configured to have a zero mm 
offset.   

 

 

PERSONNEL 

   

  Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 

        (540) 373‐1243 

 

  Charles Geoghegan  NOAA/NOS/NGS/GSD?I&M BRANCH 

        (540) 373‐1243 

NOAA SURVEY VESSEL S1212 

POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
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ESTABLISHING THE REFERENCE FRAME 

 

The target atop the Inertial Motion Unit (IMU) served as the primary reference point for this survey  To 
conduct this survey a local coordinate reference frame was established where the Northing (Y) axis runs 
along the centerline of the boat and is positive from the primary reference point towards the bow of the 
boat.  The Easting (X) axis is perpendicular to the centerline of the boat and is positive from the primary 
reference point towards the right, when looking at the boat from the stern.  The Up (Z) axis is positive in 
an upward direction from the primary reference point.  In this reference frame IMU, the primary 
reference point, has the following coordinates; 

X = 100.000(m) 

Y = 100.000(m) 

Z  = 100.000(m) 

 

A secondary centerline control point, CL1,was established atop, and at the center of the transom.  The Y 
value of CL1 was assumed to be zero.  Determination of the X value for TP1 was accomplished by 
measuring the horizontal distance from IMU. Determination of the Z value for TP1 was accomplished by 
trigonometric leveling from IMU.  The determined coordinates for CL1 are; 

X =    97.873(m) 

Y =  100.000(m) 

Z =   100.444 (m) 

 

ESTABLISHING ALL OTHER POINTS 

 

While occupying IMU, a bearing of 180.0000 was input into the instrument and CL1 was input for 
initialization. After initialization was conducted, angular and distance measurements were taken to 
establish the following points; TP1 and TP2.  TP1and TP2 are temporary points set off of the boat.  The 
established coordinates for TP2 were stored internally in the instrument.   
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While occupying TP2, the previously determined bearing to IMU was recalled and initialization was 
conducted to IMU.  After initialization was conducted, angular and distance measurements were taken 
to establish the following points; GPSP, GPSS, GPS, CL1, SSST, MB, SB, and TP1.  The established 
coordinates for TP2 were then stored internally in the instrument.  During these observations, 
coordinate checks were made to the following previously established points; 

 

TP1 

X =  0.010(m) 

Y =  0.001(m) 

Z  =  0.001(m) 

 

 

 

NOAA SURVEY VESSEL S1212 

POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

 

While occupying TP1, the previously determined bearing to TP2 was recalled and initialization was 
conducted to TP2.  After initialization was conducted, angular and distance measurements were taken 
to establish following previously determined points; 

 

IMU 

X =  0.000(m) 

Y =  0.004(m) 

Z =   0.007(m) 

 

GPSP 
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X =  0.002(m) 

Y =  0.006(m) 

Z =   0.001 (m) 

 

 

 

GPSS 

X =  0.001(m) 

Y =  0.001(m) 

Z  =  0.002(m) 

 

GPS 

X =  0.000(m) 

Y =  0.007(m) 

Z =   0.003(m) 

 

CL1 

X =  0.001(m) 

Y =  0.011(m) 

Z =   0.002 (m) 

 

SSST 

X =  0.000(m) 
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Y =  0.009(m) 

Z =   0.002(m) 

 

MB 

X =  0.000(m) 

Y =  0.007(m) 

Z =   0.002(m) 

 

 

 

NOAA SURVEY VESSEL S1212 

POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

 

SB 

X =  0.001(m) 

Y =  0.007(m) 

Z =   0.002(m) 

 

 

 

DISCUSSION 

 

All coordinates are contained in spreadsheet “S1212.xls.  Included in this spreadsheet is the IMU GPS 
antenna separation value, as determined by inverse between the positions of the two GPS antenna.  
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After reviewing the check positions, the horizontal and vertical accuracy of the unadjusted values for all 
objects is +/‐ 1 Centimeter at the 95% confidence level.   

 

The boat was surveyed on a trailer.  To level the boat up, relative to a water stain, identified by Kathryn 
Simmons as the water level mark, 3 points were identified along the stain line ( 2 at either end of the 
stern and 1 along the starboard side and near the bow).  Trigonometric height values were determined 
at these points, and the boat manipulated via the tongue jack, and two trailer jacks at the rear of the 
vessel, until the height values were in coincidence.  At this time the boat was considered to be level with 
the water level mark.  This value was recorded to be 0.022 m below the level of the IMU target. 

 

The positions given for all GPS antenna are to the top center of the antenna. To correct the Z value 
contained in the spreadsheet for each antenna to the electronic phase center, I recommend the 
following steps be taken; 

1) Measure the total height of each antenna type.  This information is probably located on the 
antenna or with equipment documentation. 

2) Investigate to find the electronic phase center offset of the antenna.  This information is 
probably located on the antenna or with equipment documentation.  This value may also be 
available at the NGS website for antenna modeling. 

3) Subtract the total height of the antenna from the spreadsheet Z value for each antenna.  This 
will give you a Z value for the antenna ARP (antenna reference point) 

4) Then add to this value the electronic phase center offset value appropriate for the antenna 
model. 
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NOAA SURVEY VESSEL S1212 

POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

 

 

 

Station Listing 

 

CL1‐    CENTERLINE SECONDARY REFERENCE POINT 

A punch mark set in top of the center of the transom. 

 

MB‐    MULTIBEAM TRANSDUCER REFERENCE POINT 

    The center of the bottom of the Multibeam Transducer. 

 

SB‐    SINGLE BEAM TRANSDUCER REFERENCE POINT 

    The center of the bottom of the Singlebeam Transducer. 

 

SSST‐    SIDE SCAN SONAR REFERENCE POINT 

A punch mark set in top of the swing arm, and directly over the pivot point for the Side 
Scan Sonar sheave.  The correction from the punch mark to the center of the Side Scan 
Sonar cable is 0.318(m) and has been accounted for in the spreadsheet value for this 
sensor. 
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IMU‐    IMU REFERENCE TARGET 

Center of a target affixed to the top of the IMU housing.  This is also the Primary 
Centerline Reference Point. 

 

GPS‐    NAVIGATION GPS ANTENNA REFERENCE POINT 

    The top center of the navigation system GPS antenna. 

 

GPSP‐    POS GPS ANTENNA REFERENCE POINT 

    The top center of the port side GPS antenna for the POS system. 

 

GPSS‐    POS GPS ANTENNA REFERENCE POINT 

The top center of the starboard side GPS antenna for the POS system. 
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Appendix 2: Wiring Diagram 
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Cable  End1  End2  Settings Description

L1  Hypack Computer 

129.100.1.230 

255.255.0.0 

Network Switch n/a Connects to SonarPro Computer, POS/MV 
and Echotrac CV 

L2  SonarPro Computer 

129.100.1.240 

255.255.0.0 

Network Switch n/a Network share with Hypack Computer for 
SSS data download 

L3  POS/MV 

129.000.1.231 

255.255.0.0 

Network Switch n/a UDP broadcast of depth, attitude, & PosPac 
data to Hypack 

L4  Echotrac CV3 

Automatic IP 

Network Switch n/a UDP broadcast to Hypack 

L5  EM3002 

157.237.2.61 

255.255.255.0 

Hypack Computer

157.237.2.30 

255.255.255.0 

Port 16103 UDP broadcast of  various EM datagrams 
(crossover) 

L6  Klein 3000 TPU 

192.168.0.81 

255.255.255.0 

SonarPro Computer

192.168.0.82 

255.255.255.0 

n/a

 

SSS data stream (crossover)

S1  POS/MV 

Com 1 

EM3002 PU 

Com 3 

9600,8,n,1 Position data to EM3002 (GGA) @ 1 Hz

S2  POS/MV 

Com 2 

EM3002 PU 

Com 2 

19200,8,n,1 Attitude data to EM3002 (Simrad 1000 TSS1) 
@ 50 Hz 

S3  POS/MV 

Com 4 

Klein 3000 TPU

Com 2 

4800,8,n,1 Position and Speed to Klein TPU (RMC & 
VTG) 
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S4  Trimble DGPS 

Port B 

POS/MV 

Com 3 

9600,8,n,1 RTCM DGPS correctors to POS/MV

S5  Trimble DGPS 

Port A 

Hypack Computer

Com 4 

9600,8,n,1 Trimble DGPS configuration via TSIP talker

S6  SonarPro Computer 

Com 1 

Klein 3000 TPU

Com 1 

9600,8,n,1 HyperTerminal connection to view Klein TPU 
bootup sequence 

S7  Hypack Computer 

Com 3 

SonarPro Computer

Com 2 

9600,8,n,1 Cable out to SonarPro via Hypack‐generated 
delph string 

S8  Cable Counter 

 

Hypack Computer

Com 5 

2400,7,n,1 Cable out from Dynapar unit to Hypack

S9  Digibar  Hypack Computer

Com 10 

9600,8,n,1 Surface sound speed to SIS for EM3002 beam 
forming/steering 

S10  AIS Transceiver  Hypack Computer

Com 6 

38400,8,n,1 AIS (automatic identification system) 
broadcast and receive  

S11  Seabird SBE 19+  Hypack Computer

Com 9 

9600,8,n,1 Download CTD cast data 

S12  POS/MV 

Com 5 

VHF radio  4800,8,n,1 Position (GGA) sent to non‐NOAA VHF radio 
for DSC (digital selective calling) capability 
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Appendix 3: GAMS Calibration Report 
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Vessel:

Date: 3/7/2011 Dn: 66

Personnel:

PCS Serial # 2245 (A014934)

IP Address:

POS controller Version (Use Menu Help > About) 3.4.00

POS Version (Use Menu View > Statistics) MV-320,  Version 4
GPS Receivers

Port Receiver
Starboard Recceiver

POS/MV Calibration Report
Field Unit:  NRT 3

SYSTEM INFORMATION
S1212

Jacobs, Jackson

129.100.1.231

1441021298
1441021080

Location: D M S
Approximate Position: Lat 47 16 12 N

Lon 122 37 48 W
DGPS Beacon Station: Robinson
Frequency: 323 kHz

Satellite Constellation
Primary GPS (Port Antenna)

HDOP: 0.091
VDOP: 1.121

Sattelites in Use: 11

PDOP 1.352 (Use View> GAMS Solution)

Note: Secondary GPS satellite constellation and number of satellites were exactly the same as the Primary GPS

19,16,3,6,14,21,9,15,18,22,27

CALIBRATION AREA
Carr Inlet, WA
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Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

User Entries, Pre-Calibration Baseline Vector
1.903 Two Antenna Separation (m) 0.015 X Component (m)
0.50 Heading Calibration Threshold 1.903 YComponent (m)

0 Heading Correction 0.025 Z Component (m)

POS/MV CONFIGURATION

Configuration Notes:   Annual Calibration

Calibration Procedure:

Start time: 10:18 UTC
End time: 10:29
Heading accuracy achieved for calibration: 0.099

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values Baseline Vector
1.903 Two Antenna Separation (m) 1.903 X Component (m)
0.500 Heading Calibration Threshold 0.5 YComponent (m)

0 Heading Correction 0.025 Z Component (m)

X
X

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name:

POS/MV CALIBRATION

(Refer to POS MV V3 Installation and Operation Guide, 4-25)

GAMS Status Online?
Save Settings?

Calibration Notes.

POSMV_2011.nvm
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The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

GENERAL GUIDANCE
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Input/Output Ports  (Use Settings > Input/Output Ports)

SETTINGS (insert screen grabs)

NOTE: COM3 and Analog are not used.
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Heave Filter  (Use Settings > Heave) Events  (Use Settings > Events)

Time Sync  (Use Settings > Time Sync)

 

 

Installation  (Use Settings > Installation)
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Appendix 4:  Sound Speed Sensors Annual Calibration 
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Appendix 5: Hydrographic Systems Inventory 
 

 

 

 

Name and Grade Current Position Years of Hydrographic 
Experience Notes

Dan Jacobs (Acting Team Lead) Physical Scientist 5

Name and Rate Current Position Years of Hydrographic 
Experience Notes

Barry Jackson Physical Science Technician 5
Ian Colvert Physical Science Technician 5

Name and Rate Current Position Years of Hydrographic 
Experience

Notes & Dates 
Embarked

Hydrographic Personnel Roster
Field Unit:  NRT3

Effective Date:  02/28/2011

Updated Through:   04/11/2011

ROTATING HYDROGRAPHERS & VISITORS (involved in survey work)

Team Members

NOTES:

Team Leader
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Effective Date Updated Through

1/4/2011 2/20/2011

Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install Date Date of last 
Calibration

Date of last Service Additional 
Information

Single Beam 
Echosounder Odom

Echotrac CV 
(ETCVX2) 23015 Acquired 10/24/2005

Multibeam 
Echosounder Kongsberg Simrad EM3002 358

DSP High/Low v1.26, 
Transducer v1.21 Unknown   4/19/2011

Dongle # 040131, 
8/1/2006

Multibeam Control 
Unit

Kongsberg Simrad EM3002 1534 Acquired 8/1/2006

Side Scan Sonar 
Towfish

Klein System 3000--Model 
3210

456 4/25/2010 In service 3/3/2004

Side Scan Sonar 
TPU

Klein System 3000 392 In service 5/20/2008 
until 5/30/2008

Side Scan Sonar 
TPU

Klein System 3000 312 In service 3/3/2004

Lead Line Traditional NA .

HYDROGRAPHIC HARDWARE INVENTORY | NRT3

SONAR & SOUNDING EQUIPMENT

Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install Date Date of last 
Calibration

Date of last Service Additional 
Information

Position/Orientation 
System Control Unit

Applanix POS/MV 320 V4  A009170 12/4/2008 calibrated 
for S1212

RA 6 POS from 
PMC.  In use for  
Hylebos barge 

investigation DN343, 
DN347, DN349 2008.

Position/Orientation 
System IMU Applanix POS/MV 320 V4 371 unknown 10/26/2011 10/26/2011 on loan from BHII

Position/Orientation 
System IMU

Applanix POS/MV 320 V4 2245 (A014934) 3.42 3/18/2008  4/20/2009 Acquired 8/1/2006

Position/Orientation 
System Control Unit 

Applanix POS/MV Model # 
MVV4

2245 (A014934) 3.42 3/18/2008 4/20/2009 Acquired 8/1/2006

Position/Orientation 
System Antennas

Trimble Zephyr Port-1441021298 
Stbd-1441021080

2.27 3/18/2008 3/7/2011 Acquired 8/1/2006

DGPS Antenna Trimble 33580-00 220330095 On launch

DGPS Reciever Trimble DSM212L 220164491 On launch

GPS Handheld 
Receiver/Datalogger

Trimble GeoXH 70950-00 TerraSync 4.2

Sound Speed Profiler 
(CTD)

Sea-Bird SeaCat SBE-19 1913768-  2039 1/15/2011 4/01/2006 5/23/2007 
1/24/2009

Acquired 9/5/2006 
from NRT-7

Sound Speed Profiler 
(CTD)

Sea-bird SeaCat SBE-19+ 19P44126-4778 12/15/2010 9/1/2006  1/30/2008  
2/12/2009

Acquired 10/10/2006

Velocimeter probe Odom Digibar Pro 98314  8/1/2007  2/12/2009

Acquired 8/1/2006  
Malfunction 05/17/07  

Repaired and in-
service 08/1/07 

Velocimeter 
Controller

Odom Digibar Pro 98308 3/15/2011 3/15/2011 In use, on survey 
launch

Velocimeter 
Controller

Odom Digibar Pro 98314  In office trailer

POSITIONING & ATTITUDE EQUIPMENT
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Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install Date Date of last 
Calibration

Date of last Service Additional 
Information

Towfish Cable 
Counter Dynapar Max Count Unknown

Machine Name OCS-W-NRT3-1 OCS-W-NRT3-2 OCS-L-NSD764992 Laptop Hypack Computer Klein Computer

Service Tag # 9VQLKB1 BVQLKB1 27SLRJ1 B7F8M41 22-291

Location Office Office Office Office Launch Launch

Make/Model Dell Precision 690 Dell Precision 690 Dell Precision T3400 Dell Lattitude D630 Dell Klein WSCU3000
Date Purchased 8/1/2006 8/1/2006 6/1/2009 ? 8/1/2006 3/3/2004
Date of Last Rebuild NA NA NA NA NA

Processor Intel Xeon 5060, 3.2 GHz 
(x2)

Intel Xeon 5060, 3.2 GHz 
(x2) Intel Core 2 Duo 3.2 GHz Intel Core 2 Duo 2.2 GHz Intel Pentium 4, 2.8 GHz Intel Pentium 3, 1.2 GHz

RAM 2 GB 2 GB 3 GB 2G 2.5 GB 523,740 KB

Video Card nVidia Quadro FX 550 nVidia Quadro FX 550 nVideo Quadro FX 1700 Intel Graphic Media 
Accelerator Driver

nVidia GeForce FX 5500 Matrox Millenium G450 
AGP

Video RAM 128 MB 128 MB 512 MB 384MB 256 MB 32 MB

Comments MAC Address:  00-13-72-
9B-8A-BF

MAC Address:  00-1A-A0-
BA-BE-12 00-22-19-2F-A8-51 MAC Address: 00-1E-4C-

8C-C0-22  Acquired from PHB In-service date 3/3/2004

IP Address 192.168.11.1 192.168.0.19 192.168..0.1 192.168.0.122 129.100.1.230 192.168.0.82

OTHER EQUIPMENT

COMPUTERS

OCS-W-NRT3-1 OCS-W-NRT3-2 (in 
repair, Silver Spring) OCS-L-NSD764992 Laptop Hypack Computer Klein Computer

Operating System
Windows 2000

5.0.2195, SP4 NA NA NA NA NA 3/3/2004
Windows XP 

5.1.2600, SP 2 8/1/2006 3/22/2007 2005 3/19/2008
SP3 9/8/2008 11/4/2008 6/8/2009 6/8/2009

Acquisition Software
Echotrac Controller

3.08 NA NA NA NA  (8/1/06) NA
EM3002 Controller

SIS 2.2 NA NA NA NA 12/5/2009 NA
HypackMAX

6.2.0.25, SP1 1/29/2007 1/21/2010 NA NA 8/1/2006 NA
6.2a 5/18/2007
6.2b 3/18/2008
Hypack 2008 5/1/2008
Hypack 2008 SP1 9/2/2008
Hypack 2009 4/20/2009
Hypack 2010 9/1/2011

Klein Sonar Pro
9.6 NA 8/1/2006 NA NA NA 7/14/2005
11.2 3/4/2008 3/15/2008

POS-MV Controller
3.3.0.1 NA NA NA NA 8/1/2006 NA

TSIP Talker
2.0 NA NA NA NA 8/1/2006 NA

TerraSync
2.41 NA 3/15/2008 NA NA NA
3.3 2/10/2009
4.1 NA 3/10/2010

NRT3 Hydrographic Software Inventory
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Processing Software
CARIS HIPS/SIPS

6.0, SP2, HF 21 12/12/2006 N/A NA NA
6.1, SP1 7/16/2007 7/16/2007
SP1 HF 1-12 4/3/2008 4/3/2008
6.1 SP2 7/17/2008 7/17/2008 11/3/2009
SP2 HF 1 8/5/2008 8/5/2008 11/3/2009
SP2 HF 2-3 11/3/2008 11/3/2009
SP2 HF 4 11/14/2008 11/17/2008 1/14/2009
SP2 HF 5 12/29/2008 1/5/2009
SP2 HF 6 1/12/2009 1/12/2009
SP2 HF 7 2/9/2009 2/10/2009 6/8/2010
SP2HF8
CARIS 7.0 12/21/2009 12/31/2009
SP1 1/20/2010 1/20/2010
HF 1 1/20/2010 3/11/2010
HF2 3/11/2010 3/11/2010
HF3 3/11/2010 3/11/2010
HF4 3/17/2010 3/17/2010
HF5 7/29/2010

CARIS Notebook
2.2, SP1 8/1/2006 N//A NA NA
3 ?? 3/1/2007 5/5/2009
3, SP1 6/8/2010 5/5/2009
3.1 11/5/2009 12/17/2009
3.1, HF1 11/9/2009 3/11/2010

Support Software
HydroMI

6.8.1 8/1/2006 8/1/2006 NA NA
6.10.2 1/29/2007 10/24/2006
8.1 7/2/1905
8.3

MapInfo
8.5 8/1/2006 NA NA
9.0.2 9/24/2007 3/6/2008
9.5 10/14/2008 6/8/2009
V9.5.1 6/8/2009 6/8/2009
10 11/19/2009 11/19/2009

Pathfinder Office
3.0 8/1/2006 N/A NA NA
4.1 6/8/2009
4.2 3/1/2010

Pydro
6.4.9 8/1/2006 8/1/2006 NA NA
6.10.0 10/31/2006 10/31/2006
6.10.1 12/12/2006 12/12/2006
7.1.0 1/29/2007 1/29/2007
7.3.0 5/7/2007 3/22/2007
9.4 4/14/2009 4/14/2009 6/8/2009
9.6 7/13/2009
9.1 3/10/2010
9.9 (r2712) 3/11/2010

SBE
5.27a 8/1/2006 3/22/2007 NA N/A 8/1/2006 NA
5.37e 3/10/2010

Seaterm
1.3 8/1/2006 3/22/2007 NA N/A 8/1/2006 NA
1.57 3/18/2010 5/1/2007
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VelocWin
8.8 8/1/2006 8/1/2006 NA N/A 8/1/2006 NA
8.83 1/29/2007 3/22/2007 1/29/2007 NA
8.85 5/7/2007 5/7/2007 NA
8.86 5/21/2007 5/21/2007 NA
8.96

Vertical Mapper
2.0.0 8/1/2006 3/22/2007 NA NA NA

Adobe Acrobat Professional
7.0 8/1/2006 3/22/2007 6/8/2009 4/4/2008 NA NA

Buffalo Tera Navigator
1.2.0 1/8/2006 3/22/2007 NA N/A NA NA

Microsoft Office Professional
Verson 2003
SP2 8/1/2006 3/22/2007 NA NA
Version Plus 2007 2/18/2009 2/18/2009 6/8/2009
SP2 6/8/2009

PosPac MMS
NA NA NA NA NA

5.2, SP1
5.3 3/12/2010
5.3, SP1

Acquisition
SonarPro
HYPACK 2009a 15686383  2/2/2010

HYSWEEP
Hysweep Key, parallel 

interface, Dongle # 040131, 
8/1/2006

TerraSync 2.30
SN 0021101404503274, Key 
1B02AFEA

TerraSync 2.41
509645-00110-06002-
54ED070D

Terrasync 3.30
509645-00110-09227-
4D565538

Processing
CARIS HIPS/SIPS CW9605098 CW9605485 CW9606060 (RA_key)
CARIS Notebook CW9604697
PF Office (HSTP Key) 02368-00300-04325-0B4698A3
PF Office 4.0 030602-00300-10001-DEF24AC1
POSPac MMS

Support
MapInfo 10.0 S/N: MINWEU1000051173; ACCESS CODE:398338

Keys and Licenses



OPR‐N360‐NRT3‐11  Data Acquisition and Processing Report  April – December 2011 

 

 

70 

 

 

 

 

 

 

 

 

 

 

 

 

Vessel Name

NOAA Launch 1212

Hull Number S1212

Call Letters S1212

Manufacturer Sea  Ark

Year of Construction 2000

Type of Construction Aluminum

Length Overall 32

Beam 2.4 m (8 ft)

Draft 0.4 m

Date of Effective Full Vessel 
Static Offset Survey

6/21/2006

Organization which 
Conducted the Effective Full 
Offset Survey

NGS

Date of Last Partial Survey or 
Offset Verification & Methods 
Used
Date of Last Static Draft 
Determination & Method 
Used

4/5/2011

Date of Last Settlement and 
Squat Measurements & 
Method Used

3/17/2011               
MBES used to determine 

settlement & squat

Additional Information

Field Unit:  NRT3

SURVEY VESSELS

Hydrographic Vessel Inventory

Updated Through:  8/6/2011

Effective Date:  1/31/2007
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Appendix 6:  Hydrographic Vessel File (HVF) 
 

 

Vessel Name: NRT3_2011_EM3002.hvf 
Vessel created: November 15, 2011 
 
 
Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2009-345 00:00 
 
 Comments: EM3002 replaced old EM3000 in 12/09 
 Time Correction(s) 0.000 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: -0.175 
 Azimuth Offset: 0.050 
 
 DeltaX: -0.003 
 DeltaY: -0.032 
 DeltaZ: 0.631 
 
 Manufacturer:  Kongsberg 
 Model:   em3002 
 Serial Number:   
 
Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2010-074 00:00 
 
 Comments: 2010 HSRR Patch Test in Anacortes, WA, no sonar offsets are 
entered in SIS 
 Time Correction(s) 0.000 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: -0.177 
 Roll Offset: -0.150 
 Azimuth Offset: -0.009 
 
 DeltaX: -0.003 
 DeltaY: -0.032 
 DeltaZ: 0.631 
 
 Manufacturer:  Kongsberg 
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 Model:   em3002 
 Serial Number:   
 
Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2010-096 00:00 
 
 Comments: sonar offsets were entered in SIS, BUT because we had the 
"Use EM combined..." option NOT checked, the vertical sonar offset was not 
reflected in the data logged to hsx files 
 Time Correction(s) 0.000 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: -0.177 
 Roll Offset: -0.150 
 Azimuth Offset: -0.009 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.631 
 
 Manufacturer:  Kongsberg 
 Model:   em3002 
 Serial Number:   
 
Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2010-097 00:00 
 
 Comments: sonar offsets were entered in SIS, and because we had the 
"Use EM combined..." option NOT checked, the vertical sonar offset was not 
reflected in the data logged to hsx filessonar offsets were entered in SIS, 
BUT because we had the "Use EM combined..." option checked, they are 
reflected in the data logged to hsx files, so we don't need to have in HVF 
 Time Correction(s) 0.000 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: -0.177 
 Roll Offset: -0.150 
 Azimuth Offset: -0.009 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:  Kongsberg 
 Model:   em3002 
 Serial Number:   
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Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2011-109 00:00 
 
 Comments:  
 Time Correction(s) 0.000 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: 0.080 
 Roll Offset: -0.080 
 Azimuth Offset: 0.100 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.631 
 
 Manufacturer:  Kongsberg 
 Model:   em3002 
 Serial Number:  308 
 
Depth Sensor: 
 
 Sensor Class:  Swath 
 Time Stamp:  2011-298 00:00 
 
 Comments: POS MV IMU replaced DN298 2011 
 Time Correction(s) 0.000 
 
 Transduer #1: 
 ------------- 
 Pitch Offset: -0.920 
 Roll Offset: -0.150 
 Azimuth Offset: -0.110 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:  kongsberg 
 Model:   em3002 
 Serial Number:   
 
_________________________________________________________ 
Navigation Sensor: 
 
 Time Stamp:  2006-234 00:00 
 
 Comments: RP 
 Time Correction(s) 0.000 
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 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV4 
 Serial Number:  (null) 
 
 
 Time Stamp:  2009-345 00:00 
 
 Comments:  
 Time Correction(s) 0.000 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:   
 Model:    
 Serial Number:   
 
 
 Time Stamp:  2010-074 00:00 
 
 Comments:  
 Time Correction(s) 0.000 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV4 
 Serial Number:   
 
 
 Time Stamp:  2011-109 00:00 
 
 Comments:  
 Time Correction(s) 0.000 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:   
 Model:    
 Serial Number:   
 
 
 Time Stamp:  2011-298 00:00 
 
 Comments: Replaced POS MV IMU 
 Time Correction(s) -0.020 
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 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV4 
 Serial Number:   
 
_________________________________________________________ 
Gyro Sensor: 
 
 Time Stamp:  2006-234 00:00 
 
 Comments: (null) 
 Time Correction(s) 0.000 
 
 
 Time Stamp:  2009-345 00:00 
 
 Comments:  
 Time Correction(s) 0.000 
 
 
 Time Stamp:  2010-074 00:00 
 
 Comments:  
 Time Correction(s) 0.000 
 
_________________________________________________________ 
Heave Sensor: 
 
 Time Stamp:  2006-234 00:00 
 
 Comments: (null) 
 Apply Yes 
 Time Correction(s) 0.000 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 Offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV4 
 Serial Number:  (null) 
 
 
 Time Stamp:  2009-345 00:00 
 
 Comments:  
 Apply No 
 Time Correction(s) 0.000 
 DeltaX: 0.000 
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 DeltaY: 0.000 
 DeltaZ: 0.000 
 Offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS MV4 
 Serial Number:   
 
 
 Time Stamp:  2010-074 00:00 
 
 Comments: heave applied real time in SIS 
 Apply No 
 Time Correction(s) 0.000 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 Offset: 0.000 
 
 Manufacturer:   
 Model:    
 Serial Number:   
 
 
 Time Stamp:  2011-109 00:00 
 
 Comments:  
 Apply Yes 
 Time Correction(s) 0.000 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 Offset: 0.000 
 
 Manufacturer:   
 Model:    
 Serial Number:   
 
_________________________________________________________ 
Pitch Sensor: 
 
 Time Stamp:  2006-234 00:00 
 
 Comments: (null) 
 Apply Yes 
 Time Correction(s) 0.000 
 Pitch offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV4 
 Serial Number:  (null) 
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 Time Stamp:  2009-345 00:00 
 
 Comments:  
 Apply No 
 Time Correction(s) 0.000 
 Pitch offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS MV4 
 Serial Number:   
 
 
 Time Stamp:  2010-074 00:00 
 
 Comments: pitch applied real time by SIS 
 Apply No 
 Time Correction(s) 0.000 
 Pitch offset: 0.000 
 
 Manufacturer:   
 Model:    
 Serial Number:   
 
_________________________________________________________ 
Roll Sensor: 
 
 Time Stamp:  2006-234 00:00 
 
 Comments: (null) 
 Apply Yes 
 Time Correction(s) 0.000 
 Roll offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS/MV4 
 Serial Number:  (null) 
 
 
 Time Stamp:  2009-345 00:00 
 
 Comments:  
 Apply No 
 Time Correction(s) 0.000 
 Roll offset: 0.000 
 
 Manufacturer:  Applanix 
 Model:   POS MV4 
 Serial Number:   
 
 
 Time Stamp:  2010-074 00:00 
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 Comments: applied real time by SIS 
 Apply No 
 Time Correction(s) 0.000 
 Roll offset: 0.000 
 
 Manufacturer:   
 Model:    
 Serial Number:   
 
_________________________________________________________ 
Draft Sensor: 
 
 Time Stamp:  2006-234 00:00 
 
 Apply Yes 
 Comments: (null) 
 Time Correction(s) 0.000 
 
 Entry 1) Draft: 0.000 Speed: 4.599 
 Entry 2) Draft: -0.003 Speed: 5.171 
 Entry 3) Draft: 0.029 Speed: 5.853 
 Entry 4) Draft: 0.028 Speed: 6.685 
 Entry 5) Draft: 0.044 Speed: 7.361 
 Entry 6) Draft: 0.014 Speed: 8.013 
 Entry 7) Draft: 0.032 Speed: 8.421 
 Entry 8) Draft: -0.013 Speed: 9.251 
 Entry 9) Draft: -0.064 Speed: 10.503 
 Entry 10) Draft: -0.048 Speed: 11.848 
 Entry 11) Draft: -0.140 Speed: 14.153 
 
 Time Stamp:  2009-345 00:00 
 
 Apply No 
 Comments: ERS 
 Time Correction(s) 0.000 
 
 
 Time Stamp:  2010-074 00:00 
 
 Apply Yes 
 Comments:  
 Time Correction(s) 0.000 
 
 Entry 1) Draft: 0.014 Speed: 4.675 
 Entry 2) Draft: 0.010 Speed: 5.332 
 Entry 3) Draft: 0.024 Speed: 5.985 
 Entry 4) Draft: 0.032 Speed: 6.778 
 Entry 5) Draft: 0.032 Speed: 7.394 
 Entry 6) Draft: 0.036 Speed: 7.935 
 Entry 7) Draft: 0.036 Speed: 8.162 
 Entry 8) Draft: 0.037 Speed: 8.627 
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 Entry 9) Draft: 0.020 Speed: 9.334 
 Entry 10) Draft: -0.011 Speed: 10.536 
 Entry 11) Draft: -0.049 Speed: 12.415 
_________________________________________________________ 
TPU 
 
 Time Stamp:  2009-345 00:00 
 
 Comments:  
 Offsets  
 
 Motion sensing unit to the transducer 1  
  X Head 1 -0.003 
  Y Head 1 -0.032 
  Z Head 1 0.631 
 Motion sensing unit to the transducer 2 
  X Head 2 0.000 
  Y Head 2 0.000 
  Z Head 2 0.000 
 Navigation antenna to the transducer 1 
  X Head 1 -0.947 
  Y Head 1 3.288 
  Z Head 1 3.376 
 Navigation antenna to the transducer 2 
  X Head 2 0.000 
  Y Head 2 0.000 
  Z Head 2 0.000 
 
 Roll offset of transducer number 1 0.000 
 Roll offset of transducer number 2 0.000 
 
 Heave Error: 0.050 or 5.000'' of heave amplitude. 
 Measurement errors: 0.020 
 Motion sensing unit alignment errors 
 Gyro:0.500 Pitch:0.010 Roll:0.010 
 Gyro measurement error: 0.020 
 Roll measurement error: 0.020 
 Pitch measurement error: 0.020 
 Navigation measurement error: 0.700 
 Transducer timing error: 0.010 
 Navigation timing error: 0.001 
 Gyro timing error: 0.001 
 Heave timing error: 0.001 
 PitchTimingStdDev: 0.001 
 Roll timing error: 0.001 
 Sound Velocity speed measurement error: 0.000 
 Surface sound speed measurement error: 0.000 
 Tide measurement error: 0.000 
 Tide zoning error: 0.000 
 Speed over ground measurement error: 0.030 
 Dynamic loading measurement error: 0.030 
 Static draft measurement error: 0.050 
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 Delta draft measurement error: 0.010 
 StDev Comment: (null) 
_________________________________________________________ 
Svp Sensor: 
 
 Time Stamp:  2006-234 00:00 
 
 Comments:  
 Time Correction(s) 0.000 
 
 Svp #1: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: -0.003 
 DeltaY: -0.032 
 DeltaZ: 0.631 
 
 SVP #2: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 
 Time Stamp:  2006-248 00:00 
 
 Comments: (null) 
 Time Correction(s) 0.000 
 
 Svp #1: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: -0.003 
 DeltaY: -0.032 
 DeltaZ: 0.631 
 
 SVP #2: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
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 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 
 Time Stamp:  2009-345 00:00 
 
 Comments:  
 Time Correction(s) 0.000 
 
 Svp #1: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: -0.003 
 DeltaY: -0.032 
 DeltaZ: 0.631 
 
 SVP #2: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 
 Time Stamp:  2010-074 00:00 
 
 Comments: data is NOT SVP corrected in CARIS at present time because 
Hypack receives already ray-traced depths 
 Time Correction(s) 0.000 
 
 Svp #1: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: -0.003 
 DeltaY: -0.032 
 DeltaZ: 0.631 
 
 SVP #2: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
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 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 
 Time Stamp:  2010-096 00:00 
 
 Comments: data is NOT SVP corrected in CARIS at present time because 
Hypack receives already ray-traced depthsdata is NOT SVP corrected in CARIS 
at present time because Hypack receives already ray-traced depths 
 Time Correction(s) 0.000 
 
 Svp #1: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.631 
 
 SVP #2: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 
 Time Stamp:  2010-097 00:00 
 
 Comments: data is NOT SVP corrected in CARIS at present time because 
Hypack receives already ray-traced depthsdata is NOT SVP corrected in CARIS 
at present time because Hypack receives already ray-traced depths 
 Time Correction(s) 0.000 
 
 Svp #1: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 SVP #2: 
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 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 
 Time Stamp:  2011-109 00:00 
 
 Comments:  
 Time Correction(s) 0.000 
 
 Svp #1: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.631 
 
 SVP #2: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 
 Time Stamp:  2011-298 00:00 
 
 Comments:  
 Time Correction(s) 0.000 
 
 Svp #1: 
 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
 SVP #2: 
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 ------------- 
 Pitch Offset: 0.000 
 Roll Offset: 0.000 
 Azimuth Offset: 0.000 
 
 DeltaX: 0.000 
 DeltaY: 0.000 
 DeltaZ: 0.000 
 
_________________________________________________________ 
WaterLine: 
 
 Time Stamp:  2006-234 00:00 
 
 Comments: RP to WL as surveyed 
 Apply Yes 
 WaterLine 0.020 
 
 Time Stamp:  2009-345 00:00 
 
 Comments: HOOD RIVER ERS 
 Apply No 
 WaterLine 0.000 
 
 Time Stamp:  2010-074 00:00 
 
 Comments: Anacortes HSRR 
 Apply Yes 
 WaterLine -0.022 
 
 Time Stamp:  2010-096 00:00 
 
 Comments: the water line was entered into SIS, BUT because we did not 
have the "Use EM Combined..." option checked in Hyspwee Hardware, it was not 
included in the data stored in the hsx. 
 Apply Yes 
 WaterLine -0.022 
 
 Time Stamp:  2010-097 00:00 
 
 Comments: the water line is accounted for in SIS (the "Use EM 
Combined..." option was checked (therefore, it's reflected in the data stored 
in the hsx) 
 Apply No 
 WaterLine 0.000 
 
 Time Stamp:  2011-109 00:00 
 
 Comments: waterline is not accounted for during acquisition.  ("Use EM 
Combined..." option NOT checked.) 
 Apply Yes 
 WaterLine -0.022 
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_________________________________________________________ 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 

 



OPR‐N360‐NRT3‐11  Data Acquisition and Processing Report  April – December 2011 

 

 

86 

 

Appendix 7: Lead Line Calibration 
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Checked by:                        
B.Jackson
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Appendix 8: Processing Flow Diagrams 
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Feature Processing Flow Diagram (Pydro) 
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Feature Processing Flow Diagram, CARIS Notebook 

 

 

   



OPR‐N360‐NRT3‐11  Data Acquisition and Processing Report  April – December 2011 

 

 

91 

 

 

 

Multibeam Processing Flow Diagram 
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